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Table 1. Changes to this manual

Date Description

December 15, 2011

Release 6.8.2
• "New Features” on page 1
• "Improvements” on page 1
• "Fixes” on page 1
• "Video Export Log File” on page 2
Correction
• "Export Video” on page 20 - The filename is saved as <CameraName> - <Capture 

Resolution> - <Capture FPS> - <Capture Format>_YYYYMMDD_HHMMSS. 

December 6, 2011

Release 6.8.1
• "Improvements” on page 3
• "Fixes” on page 3
• "Video Export: File Partition Size” on page 4

November 30, 2011
Added:
Cross-references to Client User Guide and Administration and Analytics Guide for 
described features.

November 29, 2011 
Added:
"To launch the PTZ Calibration tool:” on page 29 and “Figure 25. Right-click on PTZ 
Camera in Camera Tree” on page 29

November 28, 2011 Release 6.8.0.1
• "Fixes” on page 5

November 25, 2011

Release 6.8
• "New Features” on page 6
• "Improvements” on page 16
• "Fixes” on page 27
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Release 6.8.2  Release Notes
Release Notes

Release 6.8.2

New Features

Improvements

Fixes

AIR-14533

Video Export: Exported video now contains data that is traceable for legal purposes. 
The export file contains a MD5 checksum (a digital signature). It is used to verify that 
the video file has not been altered. For details, see “Video Export Log File” on page 2.

AIR-14865

Support for FLIR D-Series PTZ Cameras. 
Note: You must change video settings on camera web page and then follow 
instructions to restart the camera for settings to take effect.

AIR-14774 Bosch Autodome PTZ camera calibrated for use with PT090 video analytic engine

AIR-14852 Video Export: 700MB file now fits on 700 MB CD

AIR-14857

Phoenix devices: Input number corrected. Digital I/O interface now displays same 
numbering used in the Rules/alarms. Also now automatically numbers the 
inputs/outputs with the module number, for example, Input 1-1. (Module number 
included in default name, but default name can be changed by user if necessary.)

AIR-14871 Autotracking no longer turning on inadvertently and locking PTZ cameras
Release Notes 1



Video Export Log File  Release Notes
Video Export Log File

By default, the video file and a log file will be saved on your Desktop.

• The video filename is saved as <CameraName> - <Capture Resolution> - <Capture FPS> - 
<Capture Format>_YYYYMMDD_HHMMSS with the .avi or .aira extension. The date and time 
reflects the start of the recorded clip.

• The video log file is named in the same manner as the video file but with a .txt extension. The 
exported video file contains an MD5 checksum (a digital signature). It is used to verify that the 
video file has not been altered. 

• To verify the checksum, you must run md5sum against the video file and verify that the number 
matches the value in the log file. See the Aimetis Knowledge Base for instructions: 
http://www.aimetis.com/Support/kbarticle.aspx?ID=10086
Release Notes 2
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Release 6.8.1  Release Notes
Release 6.8.1

Improvements

Fixes

AIR-14766
Video Export: User can configure file partition size for AVI and Symphony Video (.AIRA) 
exports. See “Video Export: File Partition Size” on page 4.

AIR-14767 Playing (starting) historical video optimized.

AIR-14763
Video Export: User can now successfully seek AVI files that contain audio and the 
quality of exported AVI has been improved.

AIR-14764 Video Export: Large AVI exports can now be played after exported from Symphony.

AIR-14765 Video no longer stops due to disk performance issues.

AIR-14768 Can now start video in reverse (synchronous history in past direction).

AIR-14769 Video Export: AVI files play at normal speed after being exported.

AIR-14770 Restore a Backup now restores user management settings properly.

AIR-14773
When attempting to export video to Symphony Video (.AIRA) file, user no longer 
receives COM exception.

AIR-14787 New video decorations writing to disk properly.

AIR-14792
Light level of live video in Symphony Client for Panasonic SC-385 camera in H264 Video 
Format mode now matches the light level of live video in camera web page.
Release Notes 3



Video Export: File Partition Size  Release Notes
Video Export: File Partition Size

• Files are created by default in approximately 640 MB segments. From the Split Files at drop-down 
list in the Export Video dialog box, you can now select file size segment: 10, 100, 640, 700, or 
2000 MB. You can also enter any value in the field between 2 and 2000 MB.

• Consecutive files have a timestamp that represents the start of that file.

Figure 1. New Split Files at Option in Export Video dialog box
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Release 6.8.0.1  Release Notes
Release 6.8.0.1

Fixes

Release 6.8

• “New Features”
• “I/O Devices on Maps ADAM, Phoenix, and Axis Camera I/O” on page 7
• “Display 4 Historical Video Streams Concurrently in Fast Forward Mode” on page 9
• “When Single Sign-On (SSO) is Enabled” on page 10
• “How to Enable Single Sign-On” on page 11
• “DIO notifications for Phoenix Devices” on page 15

• “Improvements” on page 16
• “Map Links” on page 18
• “Default Renderer for Client Display - Video Mixing Renderer 9, custom presenter” on 

page 19
• “Export Video” on page 20
• “Digital I/O States Displayed in Device Tree” on page 21
• “Show/Hide Digital I/O in Device Tree” on page 22
• “Easily extend and reshape the counting line in Objects Counts Across a Line Report” on 

page 23
• “Email Distribution Option for Reports” on page 24
• “VE150 Versus VE180 BETA- Which analytic should you select?” on page 25

• “Fixes” on page 27
• “PTZ Camera Calibration - BETA” on page 29

• “Supported PTZ Cameras - Calibrated and Non-Calibrated” on page 30

AIR-14680
Video Export: Intermittent exporting issues for MJPG and MPEG4 video in .aira format 
resolved
Release Notes 5



New Features  Release Notes
New Features

AIR-9621 “I/O Devices on Maps ADAM, Phoenix, and Axis Camera I/O” on page 7

AIR-10493 

Display at least 4 historical video streams concurrently in Fast Forward mode while 
Lock times on Navigation is active. See “Display 4 Historical Video Streams 
Concurrently in Fast Forward Mode” on page 9.

AIR-11882 

Improvement of layout of alarm email subject line. Now displayed as:
Symphony Alarm - [farm name] - [camera name] - [rule/alarm name] - 
hr:min:second.millisecond

AIR-12181 Support Toshiba cameras.

AIR-13669 Control video playback speed on multi view windows.

AIR-13581 Video Export: Save video clips larger than 2GB. See “Export Video” on page 20.

AIR-14177 Single Sign-On. See “How to Enable Single Sign-On” on page 11.

AIR-14317
Add DIO notifications to Phoenix devices. See “DIO notifications for Phoenix Devices” 
on page 15.

AIR-14341 Digital I/O for Aimetis E3200 listed in the Camera Tree dialog box
Release Notes 6



I/O Devices on Maps ADAM, Phoenix, and Axis Camera I/O  Release Notes
I/O Devices on Maps ADAM, Phoenix, and Axis Camera I/O 

The Edit Maps dialog box contains a Devices tab listing all cameras and digital input and output devices. Along 
with ADAM devices, you can now use Phoenix, and Axis Camera I/O devices.

Figure 2. Digital I/O on map displayed with arrow icons

See Aimetis Symphony Administration and Analytics Guide  - “Adding Digital Input and Output to Maps 
(ADAM, Phoenix, and Axis Camera I/O devices only)” on page 64.

Important: The Show Digital I/O option must be enabled in Device Tree 
Configuration dialog box for the digital I/O to be displayed, regardless of which 
specific inputs/outputs are selected. See “Show/Hide Digital I/O in Device Tree” 
on page 22.
Release Notes 7



I/O Devices on Maps ADAM, Phoenix, and Axis Camera I/O  Release Notes
Figure 3. Adding an Axis Camera with Digital I/O 
invokes a Digital I/O tab in the Server Configuration dialog box

Figure 4. Digital I/O tab for Axis Cameras in Server Configuration dialog box

See Aimetis Symphony Administration and Analytics Guide  - “Digital I/O Tab” on page 19.
Release Notes 8



Display 4 Historical Video Streams Concurrently in Fast Forward Mode  Release Notes

See Aimetis Symphony 
Client User Guide - “Display 
Four Historical Video 
Streams Concurrently in Fast 
Forward Mode” on page 34.

If some cameras do not have 
video for the start time the 
user has specified, one or 
more panels may display 
video for 1 second from a 
future time while the panels 
synchronize.
Display 4 Historical Video Streams Concurrently in Fast Forward 
Mode

You can play 4 historical synchronized video streams in Fast Forward mode or Reverse mode at 16 times real 
speed concurrently using the Lock times on navigation feature.

Figure 5. Four panels - Lock on time navigation enabled

Figure 6. All 4 videos in Fast Forward mode
“No footage found message” displayed in panel of camera with no recorded video for a particular time
Release Notes 9



When Single Sign-On (SSO) is Enabled  Release Notes
When Single Sign-On (SSO) is Enabled

SSO is transparent to the user; there are no specific messages associated with it. When registering to a new farm 
or editing an existing farm having Windows Authentication selected, the following message is displayed in case 
of failure: Windows Authentication Failed. You must enter the user and the password.

SSO works alongside the current/existing Symphony authentication process. Windows authentication is more 
secure than Symphony authentication; it makes use of the built-in Windows security system. Communication 
between client and server is made through a WSE 3.0 SOAP Web Service.

Process Flow
1. When Symphony Client connects to a farm, it creates a security token, based on the identity of the 

currently logged-in Windows user; the user MUST have logged-in on the domain account.

2. The security token is sent to the farm/server for authentication.

3. Farm/server verifies that the token is valid and determines the domain account associated with it.

4. Upon success, farm/server sends a session ID back to the client.

5. On failure, the client’s farm state changes to Unauthorized.

6. In case of failure, the user can login using Symphony credentials:

a. In Symphony Client, right-click your farm in Server List.
b. Select Edit. The Server Login Information dialog box opens.
c. Disable single sign-on: clear the Windows Authentication check box.
d. Click OK.
e. Enter user name and password.

Prerequisites
The Single Sign On feature uses the client’s domain identity to authenticate to the server; therefore, the client 
and the server must be in the same security realm. As such, the Single Sign On feature is available only when:

• Client and server machines are logged on to the same domain, and
• The user logs on to the client machine as a domain user by using the domain credentials. (A user 

can log on to a machine locally in which case the Single Sign On feature is not available.)
On domains controlled by Windows Server 2008 (or later) and clients running Vista/Windows 7:

• AES256_HMAC_SHA1 encryption must be disabled because it cannot be handled by the WSE 3.0 
used by Single Sign On. This policy must be enforced by the domain controller and must be set by 
the IT personnel in charge of the domain.

Important: If users need their registered farms available on any machine on the 
domain, they must enable roaming user profile (Windows).

Important: Multiple Symphony Clients on a single Windows login (each 
registered with a different user) are needed to run Live Ban. As such, Single 
Sign On will not be available for Video Walls when also running Live Ban.
Release Notes 10



How to Enable Single Sign-On  Release Notes
How to Enable Single Sign-On

• Complete the following tasks:
• “Task 1: In Symphony Client (or manually) enable single-sign on” on page 11
• “Task 2: In Symphony Client, change the storage path for the farm registration to a 

network server” on page 13
• Review process flow: “DIO notifications for Phoenix Devices” on page 15

Task 1:  In Symphony Client (or manually) enable single-sign on

Procedure 

To enable or disable single sign-on in Symphony Client:
1. In Symphony Client, right-click your farm in the Server List.

2. Select Edit. The Server Login Information dialog box opens.

• To enable single sign-on, select the Windows Authentication check box. 
• To disable single sign-on, clear the Windows Authentication check box.

3. Click OK.

Figure 7. Windows Authentication check box
Release Notes 11



How to Enable Single Sign-On  Release Notes
Procedure 

To enable single sign-on manually:

1. Edit %APPDATA%\aimetis\RegisteredFarms.xml.

Example:

<RegisteredFarms>
  <Farm ID="74083">
   <Encryption>6.2</Encryption>
    <Alias>10.234.10.76</Alias>
   <SpecifiedAddress>10.234.10.76</SpecifiedAddress>
   <UserName>MVYlTEIRRUhQ</UserName>
    <Password>kjdflasdkjflakj</Password>

<UseWindowsAuthentication>false </UseWindowsAuthentication>

    <Addresses>
      <Address>
        <SpecifiedAddress>10.222.10.73</SpecifiedAddress>
        <IP>10.222.10.73</IP>
        <Port>50001</Port>
      </Address>
    </Addresses>
  </Farm>

</RegisteredFarms>
2. Under <Farm ID = “number”>, 

• To enable single sign-on set 
<UseWindowsAuthentication>true </UseWindowsAuthentication> 

• To disable single sign-on set 
<UseWindowsAuthentication>false </UseWindowsAuthentication
Release Notes 12



How to Enable Single Sign-On  Release Notes
Task 2:  In Symphony Client, change the storage path for the farm registration 
to a network server

Procedure 

To ensure that farm registration information is stored on a network server:

1. From the View menu, select Settings. The Symphony Client Settings dialog box opens.

2. Click the Global tab.

Figure 8. Global tab in the Symphony Client Settings dialog box

3. Select the Custom path to farm registration check box. 

4. In the next field enter the path on the network where the registration information will be stored for 
all roaming users.

• The network server storing all the farm registrations must be accessible from all Clients.
• This is a global setting. All users that login to this Client will use this setting. Use the 

%WINUSER% variable when configuring this path so that each user has a unique path 
where the farm registration is stored. The user must have Windows “modify” rights to 
this folder. This is set only once on each Client machine.

Important: It is a security risk to have multiple users share a farm registration.
Release Notes 13



How to Enable Single Sign-On  Release Notes
Figure 9. Changing where farm registration information is stored

See Aimetis Symphony Administration and Analytics Guide  - “Single Sign-On (SSO)” on page 33.
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DIO notifications for Phoenix Devices  Release Notes
DIO notifications for Phoenix Devices

You can now see the I/O ports that are on a Phoenix device in the Server Configuration dialog box.

Figure 10. HardwareDevice tab - I/O for Phoenix Devices

See Aimetis Symphony Administration and Analytics Guide  - “Digital I/O Tab” on page 19.

Figure 11. Phoenix I/O displayed in Camera Tree dialog box

See also “Show/Hide Digital I/O in Device Tree” on page 22. See Aimetis Symphony Administration and 
Analytics Guide  - “Figure 24. Camera Tree - How camera IDs are organized - I/O Devices with status displayed” 
on page 50 and “Figure 26. Digital I/O displayed after Show Digital I/O option selected” on page 52.
Release Notes 15



Improvements  Release Notes
Improvements

AIR-6779

Symphony Server and Client Silent Installation and Update - For details and 
instructions, see the Silent Installation Guide on the Xnet: 
https://www.aimetis.com/xnet/Support/documentation.aspx

AIR-11761 Symphony email strings now supported in different languages

AIR-14203 

Numerous fixes to Phoenix device integration (not receiving alarms if database 
stopped, digital I/O alarms not in Alarm Log, no alarms from Phoenix device after 
power loss) resulting in improved functionality.

AIR-14204 

Numerous fixes to importing cameras (Camera Export Video format MPG4 
MULTICAST; csv file field PTZ port without function; German special characters in Live 
View; export parameter set to RECORD AUDIO=YES again; importing cameras via a csv 
file failed to save changes; Camera duplicated in the system (and with same name) 
after camera import via CSV-file; some cameras are missing during second import) 
resulting in improved functionality. 

AIR-14205 
New Map Links tab in map editor (Edit Maps dialog box) allows fast way to create links. 
See “Map Links” on page 18.

AIR-14210 

Numerous fixes to Messenger feature (send message to all groups; view history; invalid 
date in message history; NullReference exception when receiving message; video wall 
frozen when Messenger displays message on screen), resulting in overall improved 
functionality.

AIR-14220 

Numerous changes to renderer VMR9 CAP integration (movie frames in historical 
video not in correct order on Axis cameras; streaming to 16 panels across 12 monitors; 
Runtime error on Video Wall; videos jerking on video walls; Symphony Player crashing 
if VMR9 selected; wrong size video with VMR9 with custom allocator Presenter; lost 
aspect ratio in Live View; Symphony Client not responding with this renderer, default 
renderer VMR9 (See “Default Renderer for Client Display - Video Mixing Renderer 9, 
custom presenter” on page 19); Live video stops when full screen enabled by 
context-menu; picture flickering on right side for Bosch FlexiDome and Dinion IP 
cameras; double image after live view resized; left side of video flickering,) resulting in 
overall improved functionality.

AIR-14223 Numerous fixes to Carousel feature resulting in overall improved functionality

AIR-14230 
Numerous fixes to video (Live Video view jerking, video wall panels black, video wall 
choppy video, video with dropped frames) resulting in improved functionality

AIR-14260 Numerous improvements related to issues with Historical video 

AIR-14268 Digital I/O icons on Map consistent when editing and viewing the map

AIR-14346 Support for Axiom RBH Server 5.2.59 Release 3

AIR-14350 Video Export Enhancements. See “Export Video” on page 20.

AIR-14351 Footage can be recorded in 1 hour segments 
Release Notes 16
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Improvements  Release Notes
AIR-14352 “Digital I/O States Displayed in Device Tree” on page 21.

AIR-14374 Hook NetRecv to AVSync for smooth video

AIR-14411 “Show/Hide Digital I/O in Device Tree” on page 22.

AIR-14437 Default Naming of Inputs and Outputs for Adam device start at 0

AIR-14440 
“Easily extend and reshape the counting line in Objects Counts Across a Line Report” 
on page 23

AIR-14441

In Heat Map Report, option to Resize image for screen resolution. If the image does not 
fit to the screen resolution, the check box will be displayed regardless of whether the 
window is maximized.

AIR-14491 JPEG performance slow

AIR-14512 Remove the Setup option from DIO in the right-click menu of the Device Tree

AIR-14513
Specify format and email recipient for report. See “Email Distribution Option for 
Reports” on page 24.

AIR-14524 ADAM device should allow for DIO selection when adding a new device

AIR-14535 Remove the Setup option from DIO on Maps

AIR-14561 Improve logging on cleaner

AIR-14597

VE180 Analytic - now handles lighting changes with fewer false positives and has fewer 
broken tracks while tracking moving objects. Updated default settings for overhead 
versus angled camera position. See also “VE150 Versus VE180 BETA- Which analytic 
should you select?” on page 25.
Release Notes 17



Map Links  Release Notes
Map Links

A list of all maps is displayed in the new Map Links tab. You select a map that will open when the user clicks on 
a hot link (box) in the primary map. You drag the map name onto the primary map. The resulting box, which can 
be almost any size and color, is the link.

Figure 12. Map Links tab in Edit Maps dialog box

Figure 13. Change opacity and color of the link

See Aimetis Symphony Administration and Analytics Guide  - “(Optional) Creating Map Hot Links” on page 56.
Release Notes 18



Default Renderer for Client Display - Video Mixing Renderer 9, custom presenter  Release Notes
Default Renderer for Client Display - Video Mixing Renderer 9, 
custom presenter

By default, the Render Mode for the Client display is now Video Mixing Renderer 9, custom presenter.

• Less memory impact than the VMR9
• Allows more than 16 panels to be viewed when 12 monitors are attached to ATI video card

Figure 14. Symphony Client Settings dialog box, Video tab
Render Mode section

See Aimetis Symphony Client User Guide - “Figure 51. Video tab” on page 47.

Important: In previous releases, the default was Video Renderer Default. If your 
video does not play with the new default, select Video Renderer Default from 
the Renderer drop-down list.
Release Notes 19



Export Video  Release Notes
Export Video

Exporting video is now much easier. The Save Clip button and dialog box has been replaced with the Export 
button and Export Video dialog box.

• You can save the video in Symphony Video (.aira) format or in AVI format.
• The filename is saved as <CameraName> - <Capture Resolution> - <Capture FPS> - <Capture 

Format>_YYYYMMDD_HHMMSS. 
• The date and time reflects the start of the recorded clip. 
• The Symphony Video (.aira) files are created in approximately 2GB segments, with the last file 

being less than 2GB. Consecutive files have a timestamp that represents the start of that file.
• For AVI (.avi) files are created in the size associated with the Video Codec you have selected. 

These can be very large files and they are NOT segmented. When exporting large amounts of video 
using AVI, the file can be over 2GB. After the export is completed, the file cannot be played in 
Windows Media Player.

Figure 15. Export Video dialog box with Symphony Video (.aira) format selected
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Digital I/O States Displayed in Device Tree  Release Notes
Figure 16. Export Video dialog box with AVI format selected

See Aimetis Symphony Client User Guide - “Using Export” on page 73.

Digital I/O States Displayed in Device Tree

Figure 17. I/O Devices with status displayed

See Aimetis Symphony Client User Guide - “Customizing the Camera Tree” on page 15.
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Show/Hide Digital I/O in Device Tree  Release Notes
Show/Hide Digital I/O in Device Tree 

In the Device Tree Configuration dialog box, you now have the option of showing or hiding digital I/O devices. 
This is useful when the Device Tree lists numerous devices.

Figure 18. Device Tree Configuration dialog box with Options 

Figure 19. Digital I/O displayed after Show Digital I/O option selected

See Aimetis Symphony Client User Guide - “Customizing the Camera Tree” on page 15.
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Easily extend and reshape the counting line in Objects Counts Across a Line Report  Release Notes
Easily extend and reshape the counting line in Objects Counts 
Across a Line Report

Figure 20. Line tab - extending and shaping the counting line

• To extend the line: Click on the background image to create a new line segment from the existing 
line to the point clicked. 

• To delete a segment: Click the Delete Segment button, which removes the last segment. Delete 
Segment will not remove the last (original) line segment to ensure there is at least one line 
segment for the report.

• To reshape the line: Hover the mouse over the box segment end-point: the cursor changes to a 
hand. Click and drag. The cursor changes to the move shape icon (arrows) and allows you to drag 
the vertex. 

See Aimetis Symphony Client User Guide - “Figure 38. Line tab - extending and shaping the counting line” on 
page 96.
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Email Distribution Option for Reports  Release Notes
Email Distribution Option for Reports

You can now select the format and recipient list of a report in the Distribution tab the Report Designer. Formats 
include: PDF, CSV (comma separated document), and XML.

Figure 21. Distribution tab

See Aimetis Symphony Client User Guide - “Figure 33. Distribution tab showing an email list for reports” on 
page 92 and “Figure 37. Send Report to Email distribution list” on page 94.
Release Notes 24



VE150 Versus VE180 BETA- Which analytic should you select?  Release Notes
VE150 Versus VE180 BETA- Which analytic should you select?

VE150

• Consumes less CPU
• Best with mixed object types (for example, cars and people)
• Best with sparse objects (where overlap is rare)
• Calibration (tuning) is less important

VE180

• We recommend that you select the VE180 BETA only in a non-production environment
• Requires tracking region to contain only people
• Best with dense environments (people standing close together)
• Best for maintaining tracks of individual people - entire person must be visible (not partially 

occluded by a table, for example)
• With correct settings, better able to deal with challenging environments (weather, lighting, etc)
• Depends strictly on the flat ground plain assumption. See Figure 22 on page 25: the scene is 

angled; the horizon is not aligned with the horizontal and vertical axes. Compare with Figure 23 on 
page 26 where the horizon is aligned with the horizontal and vertical axes.)

Figure 22. Virtual cube does NOT fit scene
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VE150 Versus VE180 BETA- Which analytic should you select?  Release Notes
Figure 23. Virtual cube fits correctly in scene

See Aimetis Symphony Administration and Analytics Guide  - “VE180 (BETA) - Indoor/Outdoor People 
Tracking” on page 152.
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Fixes  Release Notes
Fixes

AIR-10815 TrackerApp does not work via RDP

AIR-12570 Bad video quality for Sony DH160 and CH180 

AIR-12891 Historical playback with lock times not working 

AIR-13014 Sony video choppy 

AIR-13730 Context sensitive Help not linked for new Maps and Device Tree 

AIR-13844
PTZ control has only the position from the first tour on the 8 shortcut keys although a 
different tour is active

AIR-14097 Pelco camera video displayed as grey box in Live View

AIR-14013 Remove Microsoft sysinternals tools from Symphony installer

AIR-14158 Multi-stream support for Sony DH series

AIR-14252
Problem viewing marked and unmarked alarms in correct order in Advanced Alarm 
Log

AIR-14304 Unhandled exception in NotificationReceived handler: System.NullReferenceException 

AIR-14335 Export video window title is “Play Video” 

AIR-14336 TrackerApp error “Pure virtual function called”

AIR-14338 Decorations sometimes appear translucent 

AIR-14353 DIO States displayed in the Map and Device Tree are not translatable

AIR-14355 Unsuitable log message for Dallmeier 

AIR-14360 
Assertion caused in IOModule.cs when a DIO notification arrives but the DIO modules 
have not been set up yet 

AIR-14371 PTZInfo XML is not updating after second auto-detect

AIR-14379 Panel right-click menu does not work in Videowall Manager when OPX is enabled

AIR-14382 SDK apps cannot connect to farms (Video wall, SymphonyFarmTest) 

AIR-14383 Videowall hangs in initializing state (OPX enabled)

AIR-14390 LPR setup saved in wrong backup-<timestamp> folder

AIR-14402 PT090 does not track (Pan, Tilt). See also “PTZ Camera Calibration - BETA” on page 29.

AIR-14405 
“System.InvalidOperationException: Invoke or BeginInvoke cannot be called” when 
closing with quad Multi View 

AIR-14409 Load Classic Layout loads a Carousel when selected with a Carousel open 

AIR-14410 Installation of Microsoft WSE 3.0 Runtime fails to install

AIR-14413 support I/O and VMD for 5th gen SONY cameras 

AIR-14415 Camera Tampering rule in 6.7.3.0 created many false alarms within 1 hour
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AIR-14417 Bosch NDN-921 only supported with 720x576 in interface

AIR-14435 Rendering in TrackerApp does not work 

AIR-14448 Bosch video running at 45 FPS 

AIR-14456 Symphony Client in reconnecting state and/or in initializing state

AIR-14452 Panels not displayed in docked quad view for cameras that are not running

AIR-14464 Symphony Client hangs when trying to unregister a video wall 

AIR-14472 Symphony Client hangs registering a farm 

AIR-14476 Server Configuration dialog box will not close 

AIR-14485 4-panel synchronized playback does not work in a multiple farm configuration

AIR-14493
Symphony Server crashes and CPU load 100% when a batch file is triggered by a rule 
triggered by I/O

AIR-14529
Performance problems with camera when DIO tries to connect to tracker that is 
disabled or not running

AIR-14537 Servers remains in initializing state

AIR-14539 Video does not start 

AIR-14541 Video stops after minimize - maximize main console 

AIR-14542 Alarm log marks alarms erroneously as “real” when users navigate between alarms

AIR-14545 Maps always scroll to top right when switching cameras 

AIR-14547 DIO Input/Output state does not update in the Device Tree on state change 

AIR-14560 Fail to delete camera2’s footage file. Cleaner deletes all logs associated with number

AIR-14573 LPR does not detect digits-only license plates

AIR-14582
PTZ Tour: User is unable to Update Location (in the Camera Tour dialog box) on more 
than one location at a time

AIR-14593 Vivotek dual streaming issues

AIR-14641 PTZ camera frequently showing IsHomePostion is true logging message
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PTZ Camera Calibration - BETA

The PTZ Calibration tool is for calibrating supported PTZ Cameras for use with the PT090 analytic engine ONLY. 

Do not use this tool to calibrate PTZ cameras for general usage. 

Figure 24. PTZ Calibration dialog box

To launch the PTZ Calibration tool:
1. Right-click on a PTZ camera in the Camera Tree. 

2. From the context-menu, select PTZ Calibration.

3. See “Supported PTZ Cameras - Calibrated and Non-Calibrated” on page 30.

Figure 25. Right-click on PTZ Camera in Camera Tree
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Supported PTZ Cameras - Calibrated and Non-Calibrated

See Aimetis Symphony Administration and Analytics Guide  - “PTZ Camera Calibration - Beta” on page 25 and 
“When Using a Calibrated PTZ Camera” on page 188.

Calibrated for PT090 
Analytic Engine Non-Calibrated 

• Axis 213D+
• Axis 232D+
• Axis 232D 
• Axis 233D 
• Axis Q6032
• Axis Q6035-E

• ACTi CAM-6630 

• HIKIVISION DS-2DF1-611H

• Pelco SpectraIV-IP 

• Vivotek SD7151 

If you are using a camera listed in this 
column, you must calibrate it in order to 
use the PT090 Analytic Engine.

• Axis 213 PTZ
• Axis 214 PTZ
• Axis 215 PTZ

• Bosch AutoDome100i
• Bosch AutoDome200i
• Bosch AutoDome300i
• Bosch AutoDome500i
• Bosch VG4AutoDome

• Grundig c0735P

• HIKIVISION DS-2DF1-53D
• HIKIVISION DS-2DM1-506

• Pelco Spectra HD
• Pelco Spectra III Analog

Note:  If you are already using a calibrated camera, and the camera is too slow 
when zoomed in, add the following line to the database in the Manual 
Configuration Editor in Symphony Client:
Camera   PTZ   [CameraID]   AdjustPTSpeedWithZoom   1
For instructions, see the PT090 section of the Analytics chapter of the Aimetis 
Symphony Administration and Analytics Guide.
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Known Issues

Table 1. Analytics 

ID, Title Release Additional Information

AIR-14784 
VE180 - Analytics Configuration 
not working

6.8.1

Issue in Symphony Client:
1. From Server menu , select Configuration and then 

Devices.

2. Select a device.

3. Click Analytics Configuration tab. 
Application error displayed: 
Method not found: 'Void 
PluginInterface.ConfigurationData.SetDefaultVal
ues(Boolean, Boolean)'.

WORKAROUND

1. Close Symphony Client.

2. Delete the client cache: 
%appdata%\aimetis\sc_cache

3. Restart Symphony Client.

Table 2. Camera

ID, Title Release Additional Information

AIR-12315 
Support latest Mobotix 
Firmware for VMD of camera 

6.5

VMD from Mobotix cameras is working only on 
devices running Fw. 3.4.09 (from 2008). With the Fw. 
3.5 and 4.x (running on all new models like M24, D24, 
Q24) it is not possible to use this functionality.

AIR-12896 
When adding Axis 241Q, only 
the first channel has default 
codec set Camera

6.6

When adding Axis 241Q and other multi- channel 
video servers, such as Hikvision 6104), and clicking the 
Connect to Camera button, only the first channel has 
the default codec settings. All others channels have a 
blank codec. 
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Table 3. Interface 

ID, Title Release Additional Information

AIR-12409 
Vivotek FD8361 crops image in 
stream 2 and displays stream 1 
when navigating away from 
camera 

6.5

Table 4. Data

ID, Title Release Additional Information

AIR-12113
If AI InfoService is set to log in 
as a domain user it cannot 
connect to NAS in Windows 
2008

6.7.2

If the server is running Windows 2008 and the data 
path is set to store video/data on a NAS and AI 

InfoService is set to log in as a domain user (not the 
default System account), then AI InfoService will not 
work since it cannot connect to the NAS.
Workaround:

1. InfoService must run as the Local System account. 
You can allow the services to write to a NAS share 
by giving read/write permissions on the share for 
the machine hosting InfoService.

For example, to allow InfoService running on a 
machine named Pascal, give the user "Pascal$" 
read/write access to the share on the NAS. 

2. To grant a domain user the necessary rights, enter 
the following commands in a command-prompt: 

CD c:\Windows\Microsoft.NET\Framework\v2.0.50727 
aspnet_regiis.exe -ga <user> 
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